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Introduction

This manual contains detailed instructions on the operation and maintenance of this machine. To get
maximum versatility from this machine all operators should carefully read and follow the instructions in
this manual. Please keep this manual in a handy place near the machine.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Warning:

Use of controls or adjustment or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and Acrobat® are registered trademarks of Adobe Systems Incorporated.

Ethernet® is a registered trademark of Xerox Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.

Note:

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95.

• The product name of Windows® 98 is Microsoft® Windows® 98.

• The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0
Microsoft® Windows NT® Workstation 4.0



Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine. This manual is also included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

❖❖❖❖ Printer Reference 2 (this manual)
Describes the procedures and provides necessary information about using
this machine. This manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

❖❖❖❖ Network Printing Guide
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Printer Drivers and Utilities”.
i



ii
How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's display panel.
Keys and buttons that appear on the computer's display.

{ }

Keys built into the machine's control panel.
Keys on the computer's keyboard.
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1. Raster Printer Language -
Setting Up for Printing
Windows 95/98/Me

Accessing the Printer Properties

Changing the default machine settings - Printer Properties

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the machine whose default you want to change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ With some applications, the printer driver's settings are not used, and the

application's own default is applied.

Making machine settings from an application

To make the machine settings for a specific application, open the [Printer Proper-
ties] dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows
95/98/Me.

Note
❒ The actual procedures you should follow to open the [Printer Properties] dialog

box may vary depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

Note
❒ It is possible to set basic items such as the number of copies and the print

range in this dialog box.
1



Raster Printer Language - Setting Up for Printing

2

1

BBBB Select the machine you want to use in the [Name] list box, and then click
[Properties].

The [Properties] dialog box appears.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.

Note
❒ This setting is not valid when printing from other applications.

Printer Properties Settings

Make the settings for this machine, such as the paper size for Paper Feed Tray,
the tone of images, and Output Tray options (Type A only).

Note
❒ In this section, the setting items peculiar to this machine are explained. For

other setting items, see the documentation that comes with Windows
95/98/Me or Help.

❒ In this section, Windows 98 is used for explanation purposes.

[Paper] tab

This tab contains paper related settings.

❖❖❖❖ [Paper Size]
Select the size of the paper to be printed.

❖❖❖❖ [Orientation]
Specify the printing orientation.

❖❖❖❖ [Paper source]
Specify Paper Feed Tray for printing.

❖❖❖❖ [Custom]
• Clicking this will display the [User-Defined Size] dialog box where custom

size papers can be set. This is very convenient when printing things such
as postcards and envelopes.

Reference
p.4 “Printing on custom sized paper”.

❖❖❖❖ [Copies]
Enter the number of prints required.
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❖❖❖❖ [More Options]
You can make sure the setting of Output Unit.

Note
❒ When using Type A, the optional Output Units can be attached.

❖❖❖❖ [About]
Click to display the printer driver version and copyright.

[Graphics] tab

Use this tab for setting the printing resolution, dithering and intensity.

❖❖❖❖ [Resolution]
The resolution is fixed.

Note
❒ The resolution may vary depending on the machine model.

❖❖❖❖ [Dithering]
The tone of gray shadings or photographs can be adjusted.

Note
❒ Normally, set to “Coarse”.

• “None”
Click None if you don't want any dithering.

• “Coarse”
Click Coarse if your resolution setting is 300 dpi or higher.

• “Fine”
Click Fine if your resolution setting is 200 dpi or less.

• “Line Art”
Click Line Art if your graphics include well-defined borders between
black, white, and gray shadings.

• “Error Diffusion”
Click Error Diffusion for printing photographs or pictures that don't
have sharp, well-defined edges.

❖❖❖❖ [Intensity]
Specifies how dark to print graphics in your document.
3
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Various Types of Printing

This section introduces printing examples from Windows 95/98 and Me.
Windows 98 is used for explanation purposes.

Reference
As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

It is possible to make settings for custom sized paper.

Note
❒ It is possible to register up to only one custom paper size.

AAAA Display the data to be printed.

BBBB On the [File] menu, click [Print].

The [Print] dialog box appears.

CCCC Select the machine you want to use in the [Name] list box, and then click
[Properties].

DDDD In [Paper size] on the [Paper] tab, select click [Custom].
The [User-Defined Size] dialog box appears.

EEEE Select the unit to be used for setting the values in [Units].

FFFF Enter the dimensions in the [Width] and [Length] boxes.

Important
❒ “Width” refers to the shorter edges regardless of paper direction.
❒ “Length” refers to the longer edges regardless of paper direction.

1. Length

2. Width

1

1

2

2R
R



Windows 95/98/Me

1

Note
❒ Available paper dimensions are :

• Type A
• Width : 700 - 2970 (0.1 mm units)/(2.8 - 11.7 inches)
• Length : 1480 - 4320 (0.1 mm units)/(5.9 - 17.0 inches)

• Type B
• Width : 700 - 2900 (0.1 mm units)/(2.8 - 11.5 inches)
• Length : 1480 - 4200 (0.1 mm units)/(5.9 - 16.6 inches)
Paper of a size outside these dimensions cannot be used.

GGGG Click [OK].

HHHH Click [OK].

IIII Click [OK] to start printing.

Printing on paper with a nondetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Type A

Note
❒ When using this function, make sure to set it in the [Print Size def.] in the [Set

O/L Paramet's 1/3] of the machine's Online Parameter Settings.

AAAA Press the {{{{Online}}}} key on the machine.

BBBB Press [Pnt.Size].

Note
❒ [Pnt.Size] is only displayed when the machine is online. It will not be dis-

played when the machine is offline.

CCCC Select the paper size, and then press [OK].
5
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Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

DDDD Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in the [Pnt.Size] setting on the machine.

EEEE Start printing on the computer.

Type B

Note
❒ When using this function, make sure to set it the [Print Size] in the [Online

Paramet's] of the machine's Online Parameter Settings.

AAAA Press the {{{{User Tools}}}} key on the machine.

BBBB Select [6 Online Paramet's], and then press the {{{{OK}}}} key.

CCCC Select [2 Print Size], and then press the {{{{OK}}}} key.

DDDD Select the paper size, and then press the {{{{OK}}}} key.

Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

EEEE Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in [Print Size] setting on the machine.

FFFF Start printing on the computer.
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Windows 2000/Windows XP

Accessing the Printer Properties

Changing the default machine settings - Printer Properties

Limitation
❒ Changing the settings of the machine requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options (Type A only), log on us-
ing an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP Professional, access the [Printers and Faxes] window

from [Start] on the taskbar.
❒ With Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB Click to select the icon of the machine whose default you want to change.

CCCC On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

Note
❒ With Windows XP, click [Add a printer].

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default for all applications.

Changing the default machine settings - Printing Preferences Properties

Limitation
❒ Changing the settings of the machine requires Manage Printers permission.

Members of the Administrators and Power Users groups have Manage Print-
ers permission by default. When you set up options (Type A only), log on us-
ing an account that has Manage Printers permission.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.



Raster Printer Language - Setting Up for Printing

8

1

Note
❒ With Windows XP Professional, access the [Printers and Faxes] window

from [Start] on the taskbar.
❒ With Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB Click to select the icon of the machine whose default you want to change.

CCCC On the [File] menu, click [Printing Preferences].

The [Printing Preferences] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default for all applications.

Making machine settings from an application

To make the machine settings for a specific application, open the [Print] dialog
box from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows 2000/Windows
XP:

Note
❒ The actual procedures you should follow to open the [Print] dialog box may

vary depending on the application. For more information, see the documen-
tation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].
The [Print] dialog box appears.

BBBB Select the machine you want to use in the [Select Printer] box.

Note
❒ With Windows XP, click [Preference] to open the [Printer Preference] win-

dow.

CCCC Make any settings you require and click [Print] to start printing.
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Printer Properties Settings

Make the settings for this machine, such as the paper size for Paper Feed Tray,
and the availability of options (Type A only).

Note
❒ In this section, the setting items peculiar to this machine are explained. For

other setting items, see the documentation that comes with Windows
2000/Windows XP or Help.

[Device Settings] tab

When the item to be set is clicked, a drop down list will appear on the right. Click
the list to open it and make a setting.

❖❖❖❖ [Form To Tray Assignment]
Paper sizes can be assigned to Paper Feed Tray. Normally, they are not set.
You can also select “Not Available”.

❖❖❖❖ [Installable Options]
Set connected option devices. The following item is installable:

❖❖❖❖ “Output Unit”
When Sorter is attached to Type A, select “Sorter”.

Print Setting Details 

The necessary print settings, such as paper size or print orientation, can be set
when printing from applications.
The print settings in the applications become the initial settings of the applica-
tion.

[Layout] tab

Set the print orientation and the order in which the pages are printed.

❖❖❖❖ [Orientation]
Specify the print orientation.

❖❖❖❖ [Page Order]
Specify the order in which the pages are printed. When “Front to Back” is
specified, the first page will be printed as the top page. When “Back to Front”
is specified, the first page will be printed as the last page.

❖❖❖❖ [Pages Per Sheet]
Specify the number of pages printed on one sheet of paper. For example, if
“1” is specified, one page will be printed on one sheet. If “2” is specified, two
pages will be printed on one sheet.
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[Paper/Quality] tab

Set the Paper Feed Tray to be used.

❖❖❖❖ [Tray Selection]
Specifies Paper Feed Tray for printing. 

Note
❒ Select “Paper Feed Tray” here. Even if you select “Automatically Select”,

the machine uses Paper Feed Tray for printing.

[Advanced Options] dialog box

This dialog box is displayed when you click [Advanced] on the [Paper/Quality] tab
or the [Layout] tab. Here you can set detailed items about the paper size and the
functions of the machine.

❖❖❖❖ [Paper/Output]

❖❖❖❖ “Paper Size”
Select the size of the paper to be printed.

❖❖❖❖ “Collated”
If you select more than “2” in “Copy Count”, “Collated” will become ena-
bled. Make sure to regularly clear the “Collated” check box, because if
“Collated” is not cleared, master making may be done everytime a page is
going to be printed.

❖❖❖❖ [Document Options]

❖❖❖❖ “Advanced Printing Features”
Specifies whether the advanced printing feature is enabled. For normal
printing, leave the advanced printing feature set to the default “Enabled”.

Note
❒ Normally, it is not necessary to change the default.

❖❖❖❖ “Halftoning”
Specifies the type of halftoning to use when printing graphics.

Note
❒ Normally, it is not necessary to change the default.

❖❖❖❖ “Print Optimizations”
Specifies whether the print optimization feature is enabled.

Note
❒ Normally, it is not necessary to change the default.
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❖❖❖❖ [Printer Features]

❖❖❖❖ “Printer-Side Operation”
Settings can be made using the printer driver on the computer and the ma-
chine's display panel. When “Printer-Side Operation” is set to “On”, the
following items can be set on the display panel:
• Number of print sets
• Clear Modes
• Auto-Print after Master Making
• Eco. Mode
• Job Separator
• Speed Select
• Skip Feed
• Sort

Note
❒ “Auto-Print after Master Making” is displayed on the machine's dis-

play panel as “Auto Cycle”.

❖❖❖❖ “Clear Modes”
When set to “On”, the machine settings return to their defaults before Mas-
ter Making.

❖❖❖❖ “Auto-Print after Master Making”
When set to “On”, printing starts automatically immediately after Master
Making.

❖❖❖❖ “Eco. Mode”
When set to “On”, the amount of ink consumption is reduced.

❖❖❖❖ “Job Separator”
When set to “On”, classifying will occur whenever the document data
changes.

Note
❒ When using Type A, this function is available.

❖❖❖❖ “Speed Select”
You can select the printing speed.

❖❖❖❖ “Skip Feed”
• Use to make the interval between paper feeds longer, allowing the ink

to dry.
• Use to print paper longer than the standard size.
11
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Limitation
❒ The maximum length of paper that can be printed using Skip Feed is 460

mm. However, when printing on paper longer than 432 mm, the deliv-
ered paper may fall off the paper delivery end plate. Therefore, you
should hold the paper so that it does not fall off.

❖❖❖❖ “Rotate Image”
When set to “180°”, the image will be rotated 180 degrees and printed. This
is very convenient when printing on envelopes. See p.16 “Printing onto en-
velopes” 

❖❖❖❖ “Sort”
When set to “On”, it is possible to deliver each print set in page order into
the optional sorter.

Note
❒ When using Type A, this function is available.

Various Types of Printing

This section introduces printing examples from Windows 2000/Windows XP.

Reference
As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

It is possible to make settings for custom sized paper.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

Note
❒ With Windows XP Professional, access the [Printers and Faxes] window

from [Start] on the taskbar.
❒ With Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar. Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].

BBBB On [File] menu, click [Server Properties].

The [Print Server Properties] dialog box appears.

CCCC Make sure that the [Forms] tab is displayed.

When another tab is displayed, click the [Forms] tab.

DDDD Click “Create a New Form”.
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EEEE In the [Form Description for] box, enter the name of the paper.

FFFF Under “Measurements”, set “Units”.

GGGG Enter the dimensions in the [Width] and [Height] boxes.

Important
❒ “Width” refers to the shorter edges regardless of paper direction.
❒ “Height” refers to the longer edges regardless of paper direction.

1. Height

2. Width

Note
❒ Available paper dimensions are :

• Type A
• Width : 7.00 - 29.70 cm (2.8 - 11.7 inches)
• Height : 14.80 - 43.20 cm (5.9 - 17.0 inches)

• Type B
• Width : 7.00 - 29.00 cm (2.8 - 11.5 inches)
• Height : 14.80 - 42.00 cm (5.9 - 16.6 inches)
Paper of a size outside these dimensions cannot be used.

HHHH Click [Save Form].

The paper size set is registered, and the name of the paper is added to [Forms
on].

IIII Click [Close].

It is possible to use the paper size already registered in the [Server Properties]
dialog box. When printing, select it in the [Printer Properties] dialog box.

1

1

2

2R
R
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Printing on paper with a nondetectable size

This machine automatically detects the paper size. However, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Type A

Note
❒ When using this function, make sure to set it in the [Print Size def.] in the [Set

O/L Paramet's 1/3] of the machine's Online Parameter Settings.

AAAA Press the {{{{Online}}}} key on the machine.

BBBB Press [Pnt.Size].

Note
❒ [Pnt.Size] is only displayed when the machine is online. It will not be dis-

played when the machine is offline.

CCCC Select the paper size, and then press [OK].

Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

DDDD Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in the [Pnt.Size] setting on the machine.

EEEE Start printing on the computer.
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Type B

Note
❒ When using this function, make sure to set it the [Print Size] in the [Online

Paramet's] of the machine's Online Parameter Settings.

AAAA Press the {{{{User Tools}}}} key on the machine.

BBBB Select [6 Online Paramet's], and then press the {{{{OK}}}} key.

CCCC Select [2 Print Size], and then press the {{{{OK}}}} key.

DDDD Select the paper size, and then press the {{{{OK}}}} key.

Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

EEEE Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in [Print Size] setting on the machine.

FFFF Start printing on the computer.
15
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Printing onto envelopes

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver.
The following chart shows how the image is rotated:

Note
❒ If you want to print on special types of paper such as envelopes, select the

type of paper in [Ppr.Type] on the machine's display panel. For more informa-
tion about paper type setting, see Operating Instructions.

Paper Feed 
Direction

Original Image Rotate: Off Rotate: 180°

Short Edge 
Feed

Portrait

Landscape

Long Edge Feed

Portrait

Landscape
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AAAA Rotate the envelopes 180 degrees and place them in the Paper Feed Tray as
shown.

*Paper feed direction

BBBB Set “Rotate Image” to “180°°°°” on [Advanced] on the [Layout] tab or the [Pa-
per/Quality] tab in the printer driver.

CCCC Click [Print] to start printing .

The image is rotated and printed on the envelopes.
17
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Windows NT 4.0 

Accessing the Printer Properties

Changing the default machine settings - Printer Properties

Limitation
❒ Changing the setting of the machine requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options (Type A only), log on using an account that has Full Control permis-
sion.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears .

BBBB Click to select the icon of the machine whose default you want to change.

CCCC On the [File] menu, click [Properties].
The [Printer Properties] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default for all applications.

Changing the default machine settings - Default Document Properties

Limitation
❒ Changing the setting of the machine requires Full Control access permission.

Members of the Administrators, Server Operators, Print Operators, and Pow-
er Users groups have Full Control permission by default. When you set up
options (Type A only), log on using an account that has Full Control permis-
sion.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click to select the icon of the machine whose default you want to change.

CCCC On the [File] menu, click [Document Defaults].

The [Default Document Properties] dialog box appears.

DDDD Make any settings you require and click [OK].

Note
❒ Settings you make here are used as the default for all applications.
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Making machine settings from an application

To make the machine settings for a specific application, open the [Printer Proper-
ties] dialog box from that application. The following example describes how to
make settings for the WordPad application that comes with Windows NT 4.0:

Note
❒ The actual procedures you should follow to open the [Printer Properties] dialog

box may vary depending on the application. For more information, see the
documentation that comes with the application you are using.

❒ Any settings you make in the following procedure are valid for the current
application only.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the machine you want to use in the [Name] list box, and then click
[Properties].
The [Document Properties] dialog box appears.

CCCC Make any settings you require and click [OK].

DDDD Click [OK] to start printing.

Printer Properties Settings

Make the settings for this machine, such as the paper size for Paper Feed Tray,
and the availability of options (Type A only).

Note
❒ In this section, the setting items peculiar to this machine are explained. For

other setting items, see the documentation that comes with Windows NT 4.0
or Help.

[Device Settings] tab

Click the item to be set. A change setting box will appear on the bottom of the
[Properties] window and you can make a setting.

❖❖❖❖ [Form To Tray Assignment]
Paper sizes can be assigned to Paper Feed Tray. Normally, they are not set.
You can also select “Not Available”.
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Print Setting Details

The necessary print settings, such as paper size or print orientation, can be set
when printing from applications.
The print settings in the applications become the initial settings of the applica-
tion.

[Page Setup] tab

Use this tab to make paper related settings.

❖❖❖❖ [Paper Size]
Select the size of the paper to be printed.

Limitation
❒ All of the paper sizes which are registered on Windows NT 4.0 are dis-

played. However, do not select paper sizes that cannot be used by this ma-
chine.

❖❖❖❖ [Paper Source]
Specify Paper Feed Tray for printing.

Note
❒ Select “Paper Feed Tray” here. Even if you select “Automatically Select”,

the machine uses Paper Feed Tray for printing.

❖❖❖❖ [Orientation]
Specify the print orientation.

[Advanced] tab

When clicking items to be set, the “Change Setting” box appears. Select the items
to be set from the “Change Setting” box.

❖❖❖❖ [Paper/Output]

❖❖❖❖ “Paper Size”
Select the size of the paper to be printed.

Limitation
❒ All of the paper sizes which are registered on Windows NT 4.0 are dis-

played. However, do not select paper sizes that cannot be used by this
machine.

❖❖❖❖ “Orientation”
Specify the print orientation.



Windows NT 4.0

1

❖❖❖❖ “Paper Source”
Specify a paper feed tray where the paper to be used is loaded.

Note
❒ Select “Paper Feed Tray” here.

❖❖❖❖ [Graphic]

❖❖❖❖ “Resolution”
The resolution is fixed.

Note
❒ The resolution may vary depending on the machine model.

❖❖❖❖ [Document Options]

❖❖❖❖ “Halftone Color Adjustment”
The halftone-color can be adjusted.

Note
❒ Normally, it is not necessary to change the default.

❖❖❖❖ “Paper/Output”
You can select the Output Tray.

Note
❒ When using Type A, the optional Output Units can be attached.
❒ If you select the Output Tray, this function is available, only when the

optional Output Tray is attached to the machine.

❖❖❖❖ “Scan for Rules”
The printing speed can be increased if your document contains horizontal
and vertical lines.

Note
❒ Normally, it is not necessary to change the default.

❖❖❖❖ “Print Text as Graphics”
When set to “OFF”, text placed on top of a graphic might be printed cor-
rectly if your document contains overlapping text and graphics.

❖❖❖❖ “Metafile Spooling”
When Metafile Spooling is set to “ON”, the printing information will be
converted faster.

Note
❒ Normally, it is not necessary to change the default.
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Various Types of Printing

This section introduces printing examples from Windows NT 4.0.

Reference
As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

It is possible to make settings for custom sized paper.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Printer].

The [Printers] window appear.

BBBB On [File] menu, click [Server Properties].

The [Printer Server Properties] dialog box appears.

CCCC Make sure that the [Forms] tab is displayed.
When another tab is displayed, click the [Forms] tab.

DDDD Click [Create a New Form].

EEEE In the [Form Description for] box, enter the name of the paper.

FFFF Enter the dimensions in the [Width] and [Height] boxes.

Important
❒ “Width” refers to the shorter edges regardless of paper direction.
❒ “Height” refers to the longer edges regardless of paper direction.

1. Height

2. Width

1

1

2

2R
R
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Note
❒ Available paper dimensions are :

• Type A
• Width : 7.00 - 29.70 cm (2.8 - 11.7 inches)
• Height : 14.80 - 43.20 cm (5.9 - 17.0 inches)

• Type B
• Width : 7.00 - 29.00 cm (2.8 - 11.5 inches)
• Height : 14.80 - 42.00 cm (5.9 - 16.6 inches)
Paper of a size outside these dimensions cannot be used.

GGGG Click [Save Form].

The paper size set is registered, and the name of the paper is added to [Forms on].

HHHH Click [Close].
It is possible to use the paper size already registered in the [Server Properties]
dialog box. When printing, select it in the [Printer Properties] dialog box.

Printing on paper with a nondetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Type A

Note
❒ When using this function, make sure to set it in the [Print Size def.] in the [Set

O/L Paramet's 1/3] of the machine's Online Parameter Settings.

AAAA Press the {{{{Online}}}} key on the machine.

BBBB Press [Pnt.Size].

Note
❒ [Pnt.Size] is only displayed when the machine is online. It will not be dis-

played when the machine is offline.

CCCC Select the paper size, and then press [OK].
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Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

DDDD Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in the [Pnt.Size] setting on the machine.

EEEE Start printing on the computer.

Type B

Note
❒ When using this function, make sure to set it the [Print Size] in the [Online

Paramet's] of the machine's Online Parameter Settings.

AAAA Press the {{{{User Tools}}}} key on the machine.

BBBB Select [6 Online Paramet's], and then press the {{{{OK}}}} key.

CCCC Select [2 Print Size], and then press the {{{{OK}}}} key.

DDDD Select the paper size, and then press the {{{{OK}}}} key.

Important
❒ Select a size that is bigger than the contents to be printed. If the contents

are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

EEEE Select the paper size on the computer's printer driver.

Important
❒ Select the same paper size selected in [Print Size] setting on the machine.

FFFF Start printing on the computer.



2. Canceling a Print Job
Canceling a print job (master making) is possible by using the printer driver or
the machine.

Canceling a Print Job by Using the Printer 
Driver

Canceling before the Machine Starts Master Making

AAAA Double-click the machine icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

BBBB Select the name of the job you want to cancel.

CCCC On the [Document] menu, click [Cancel Printing].

Note
❒ You can also open the print job queue window by double-clicking the ma-

chine icon in the [Printer] window.

DDDD Click [OK].

The print job is cleared.

Note
❒ When sending a print job has already begun, it may take considerable time

to be cleared.
❒ You cannot cancel the print job for a page where Master Making has al-

ready begun. In this case, follow the procedure below to stop the printing.

Canceling after the Machine Has Started Master Making

AAAA Press the {{{{Clear/Stop}}}} key on the machine's control panel.
The machine stops printing.

BBBB Double-click the machine icon on the Window taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

CCCC Select the name of the job you want to cancel.
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DDDD On the [Document] menu, click [Cancel Printing].

Note
❒ You can also open the print job queue window by double-clicking the ma-

chine icon in the [Printer] window.

EEEE Click [OK].

The print job is cleared.

FFFF Press [fin PRNT] on the machine's display panel (When using Type B, press
the {{{{OK}}}} key on the machine's control panel).
The machine returns to the status that a print job can be received.

Note
❒ The number of prints remaining is displayed on the counter after you can-

cel a print job. It will be cleared when the machine receives the next print
job, or you can clear it by pressing the {{{{Clear/Stop}}}} key.

❒ A print job that contains a large volume of data may take considerable time
to stop.

Important
❒ When multiple computers are sharing the machine, be careful not to acci-

dentally cancel someone else's print job.
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Canceling a Print Job Using the Machine 
(Job Reset)

Type A

Limitation
❒ You can cancel a print job when “Job Reset” appears on the display panel.
When a print job acquires “waiting” status during printing, these three displays
appear alternately if there are following jobs.

Canceling a “waiting” print job

AAAA Press [Job Reset].

Note
❒ You cannot cancel a print job if there are no following jobs.
❒ Even if you cancel the current print job, the following print jobs will ac-

quire “waiting” status and the three displays above will appear alternate-
ly.

Canceling a print job currently printing

AAAA Press [fin PRNT].

Note
❒ The remainder of the canceled job does not print, and then the machine

will start master making and printing the next job. When all jobs are fin-
ished, the initial display returns.
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Type B

When a print job acquires “waiting” status during printing, these three displays
appear repeatedly if there are following jobs.

Canceling a “waiting” print job

AAAA Press the {{{{Job Reset}}}} key.

Note
❒ You cannot cancel a print job if there are no following jobs.
❒ Even if you cancel the current print job, the following print jobs will ac-

quire “waiting” status and the three displays above will appear repeated-
ly.

Canceling a print job currently printing

AAAA Press the {{{{OK}}}} key.

Note
❒ The remainder of the canceled job does not print, and then the machine

will start master making and printing the next job. When all jobs are fin-
ished, the initial display returns.
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Canceling a Print Job Using the Machine

Type A

When a print job acquires “waiting” status, these three displays will appear al-
ternately if there are no following jobs.

AAAA Press [fin PRNT] on the machine's display panel.

BBBB Press the {{{{Clear/Stop}}}} key on the machine's control panel.
The machine stops master making (or printing).

Type B

When a print job acquires “waiting” status, these three displays will appear re-
peatedly if there are no following jobs.

AAAA Press the {{{{OK}}}} key.

Note
❒ The initial display returns.
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3. Uninstalling the Printer
Driver and Software
31
Uninstalling the Raster Printer Language 
Printer Driver

This section describes how to uninstall the Raster Printer Language printer driv-
er.
The actual procedures may vary depending on the operating system.
Follow the appropriate procedure below.

Windows 95/98/Me

AAAA Close all the applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the machine you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.

Windows 2000/Windows XP

Limitation
❒ Uninstalling a printer driver requires Manage Printers permission. Members

of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you uninstall a printer driver, log on using an account
that has Manage Printers permission.

AAAA Close all the applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

Note
❒ With Windows XP Professional, access the [Printers and Faxes] window

from [Start] on the taskbar.
❒ With Windows XP Home Edition, access the [Printers and Faxes] window by

clicking [Start] on the taskbar, Then click [Control Panel], [Printers and Other
Hardware] and then [Printers and Faxes].
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CCCC Click to select the icon of the machine you want to remove.

DDDD On the [File] menu, click [Delete].
A confirmation dialog box appears. 

EEEE Click [Yes] to uninstall the printer driver.

Note
❒ You can also uninstall the printer driver using the following procedure:

A In the [Printers] window, click [Server Properties] on the [File] menu to dis-
play the [Print Server Properties] dialog box.

B In the [Drivers] tab, click the driver you want to remove, and click [Re-
move].

C Click [Yes].
D Click [OK].

Windows NT 4.0

Limitation
❒ Uninstalling a printer driver requires Full Control access permission. Mem-

bers of the Administrators, Server Operators, Print Operators, and Power Us-
ers groups have Full Control Permission by default. When you uninstall a
printer driver, log on using an account that has Full Control permission.

AAAA Close all applications that are currently running.

BBBB Click [Start] on the taskbar, point to [Settings], and click [Printers].

The [Printers] window appears.

CCCC Click to select the icon of the machine you want to remove.

DDDD On the [File] menu, click [Delete]. 

A confirmation dialog box appears.

EEEE Click [Yes] to uninstall the printer driver.



4. Troubleshooting
Error & Status Messages on the Display 
Panel

Messages/Second messages Descriptions and Solutions

Cannot detect selected paper 
size. Set ### paper, then 
press [OK]. 

Printing on paper with a size undetectable by the machine has 
been requested.

Set an appropriate amount of paper in the Paper Feed Tray, and 
then press [OK] (When using Type B, press the {{{{OK}}}} key). Incon-
sistencies in the size of paper from the Paper Feed Tray will be 
ignored and printing will be performed. Press [Job Reset] to stop 
printing.

Note
❒ “###” in the message represents a paper size.

Controller Communication 
Error

The communication between the controller and the engine is ab-
normal.

First turn the power switch off and then on. If the message ap-
pears again, consult your sales or service representative.

Controller Error The ROM is faulty.

First turn the power switch off and then on. If the message ap-
pears again, consult your sales or service representative.

Making Master... The master is being made.

NVRAM Error. An error has occurred in the Memory Unit.

First turn the power switch off and then on. If the message ap-
pears again, consult your sales or service representative.

Parallel Interface Error. The parallel interface is abnormal.

Consult your sales or service representative when using the par-
allel interface.

Printing Data is being printed.

Wait until the job is finished.

<Type A only>

“Print is not finished.”

“Press [fin PRNT] for next 
mstr makg.”

(These messages appear al-
ternatively.)

Printing is not finished.

Printing has been interrupted. Perform one of the following 
procedures:

• Press the {{{{Print}}}} key, and printing will restart. Before the 
print amount display reaches 0, press the {{{{Print}}}} key to print.

• Press [fin PRNT], and printing will stop. The interrupted 
prints will not be performed.
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<Type B only>

“Processing...(Online)”

“Print is not finished (On-
line)”

“Press [finish PRNT] key to 
start next mstr makg”

(These messages appear re-
peatedly.)

Printing is not finished.

Printing has been interrupted. Perform one of the following 
procedures:

• Press the {{{{Print}}}} key, and printing will restart. When the 
printing is finished, the display returns to the initial display.

• Press the {{{{OK}}}} key, and then the interrupted printing is can-
celled. If there is the following print job, Master Making for 
it starts automatically.

• Press the {{{{Job Reset}}}} key, and printing will stop. The inter-
rupted prints will not be performed. If there is the following 
print job, these three messages appear again. If there is no 
print job, press the {{{{OK}}}} key to return to the intial display.

Processing Data is being printed.

Wait until the job is finished.

Ready for Master Mak-
ing/Printing (Online)

The Master Making or print data is not in the spool.

This is not an error. The message will change when printing 
starts from the computer.Ready for Master Mak-

ing/Printing

Resetting Job... The data spooled is dumped.

Wait until the job is finished.

ROM Error. The ROM inside the machine is abnormal.

Consult your sales or service representative.

<Type A>

Selected paper size is una-
vailable. Press [MakeMstr] to 
continue as is, or set ### pa-
per then press [OK].

The specified paper size has not been set.

Set an appropriate amount of paper, and then press [OK].

Note
❒ “###” in the message represents a paper size.

<Type B>

Selected paper size is una-
vailable.  Press [Make Mas-
ter] to continue as is,or set 
###### paper, then press 
[OK].

The specified paper size has not been set.

Set an appropriate amount of paper, and then press the {{{{OK}}}} 
key.

“###” in the message represents a paper size.

Set ###### paper, then press 
[OK].

No paper in the Paper Feed Tray.

After setting ### paper in the Paper Feed Tray, press [OK] 
(When using Type B, press the {{{{OK}}}} key) to continue.

Note
❒ “###” in the message represents a paper size.

Add paper. No paper in the Paper Feed Tray, or the Paper Feed Tray is not 
set correctly.

Make sure the Paper Feed Tray is set correctly and set an appro-
priate amount of paper. The error message will disappear.

Paper tray is not set. Open 
the papre tray.

Waiting...(Online) Waiting for data from the computer.

Wait until the job is finished.

Messages/Second messages Descriptions and Solutions
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Machine Does Not Print

If you cannot solve the problem by taking the preceding actions, contact your
sales or service representative.

Note
❒ If the Data In indicator is not blinking or lit, you can check the computer port

settings using the following procedure:

❖❖❖❖ If the machine is connected to the computer using the interface cable
❒  Make sure the computer port settings are correct. For a parallel port con-
nection, port LPT1 or LPT2 should be set. 
• Windows 95/98/Me 

A Click [Start], point to [Settings], and then click [Printers].
B Click to select the icon of the machine. Next, on the [File] menu, click

[Properties].

Possible Cause Solutions

Is the power on? Turn on the machine.

Is the interface cable prop-
erly connected?

Connect the interface cable properly.

If there are any connectors or screws, make sure that they are fas-
tened securely.

Are you using the correct 
interface cable?

Be sure to use the correct one. If the cable is damaged or worn, re-
place it with a new one.

Did you connect the inter-
face cable after turning on 
the main switch?

Be sure to connect the interface cable before turning on the main 
switch.

Is the machine Auto On 
Line?

Bring it Auto On Line by pressing the {{{{Auto On Line}}}} key.

Is the specified paper set? Set the specified paper in the Paper Feed Tray.

Are there any error mes-
sages on the display pan-
el? 

Check the error message, and take the required action.

Does the Error indicator 
stay red?

Check the error message, and take the required action.

Is the Data In indicator 
blinking or lit?

If it is not, the data does not reach the machine. Check the printer 
cable connection. Also confirm that the printer port settings are 
correct.

Can you make a proof 
print?

If you cannot print a system configuration list or a PS Font List 
from the machine, the machine might be out of order. Contact 
your sales or service representative.

Is “Waiting” displayed? Perform one of the following procedures:

• Wait until the job is finished.

• Cancel by pressing [Job Reset] (When using Type B, press the 
{{{{Job Reset}}}} key).
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C Click the [Details] tab.
D Check the [Print to the following port] box to make sure that the correct

port is selected.
• Windows 2000/Windows XP 

A Click [Start], point to [Settings], and then click [Printers].
• With Windows XP Professional, access the [Printers and Faxes] win-

dow from [Start] on the taskbar.
• With Windows XP Home Edition, access the [Printers and Fax-

es]window by clicking [Start] on the taskbar. Then click [Control
Panel], [Printers and Other Hardware] and then [Printers and Faxes].

B Click to select the icon of the machine. Next, on the [File] menu, click
[Properties].

C Click the [Port] tab.
D Check the [Print to the following port] box to make sure that the correct

port is selected.
• Windows NT 4.0 

A Click [Start], point to [Settings], and then click [Printers].
B Click to select the icon of the machine. Next, on the [File] menu, click

[Properties].
C Click the [Port] tab.
D Check the [Print to the following port] box to make sure that the correct

port is selected.

❖❖❖❖ Network Connection
❒  Contact your network administrator.
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

Multiple pages are fed through 
the machine at once.

Remove all paper from the Paper Feed Tray and fan it gently 
to get air between the sheets. After that, load it back into the 
Paper Feed Tray .

The image is printed on the re-
verse side of the paper.

Load the paper the other way up.

Paper misfeeds occur frequent-
ly.

Check the paper size settings. The size set with the paper size 
dial might be different from the actual paper size. Make the 
correct dial setting. 

Use the recommended paper. Avoid using curled, folded, 
wrinkled, perforated or glossy paper.

The display panel error message 
stays on after removing the mis-
fed paper.

Open the front cover of the machine and then close it.

It takes too much time to com-
plete the print job.

The data is so large or complex that it takes time to process 
it. If the Data In indicator is blinking, the data processing is 
being done. Just wait until it is finished.

<Windows 2000/Windows XP 
only>

Combine printing cannot be 
done as specified.

Make sure that the same orientation is set, as well as the same 
paper size set in the application.

Check the [Layout] tab.

If a different size has been set, select the correct paper size 
and orientation.

<Windows 2000/XP only>

The set option cannot be select-
ed in the print menu.

The option may not be set correctly.

Set the option correctly in the [Device Settings] tab.

The same page is being master 
made many times.

Make sure to clear the “Collated” check box in the print dia-
log box of the application.

< Windows 2000 only >

Even if the check mark is cleared in the “Collated” check box, 
master making may be done everytime a page is going to be 
printed. In this case, make sure to clear the “Collated” check 
box displayed when selecting “Copy Count” in the [Advanced 
Options] dialog box of the printer driver.

Text put under a graphic is 
printed.

• Windows 95/98/Me
Select [Print True Type as graphics] in [Fonts] tab.

• Windows 2000/XP
Click [Advanced] on the [Paper/Quality] or [Layout] tab to 
display the [Advanced Options] dialog box, and then select 
“Disable” in [Print Optimizations] in [Document Options].

When using custom sized pa-
per, the print image cannot be 
printed exactly as it appears on 
the screen.

Set the paper transversally on the Paper Feed Tray.

Enter the size of the paper in the [Width] and [Height] (or 
[Length]) boxes on the computer.
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5. Using the Control Panel
Though the default of the machine are suitable for most printing jobs, “Online
Parameter Settings” gives you access to a number of settings that control basic
printer operations. The Online Parameter settings you make are retained even
when you turn off the machine.

Reference
For more information about settings other than the Online Parameter set-
tings, see Operating Instructions.

Adjusting Online Parameter Settings 

Online Parameter Settings Menu

There are nine menu items in the “Online Parameter Settings” menu.
• Set aut-O/L def.
• Print Size def.
• List/Test Print
• IP Address
• Ethernet Speed
• Network
• I/O Timeout
• I/O Buffer
• Menu Reset
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Accessing the Online Parameter Settings

Type A

AAAA Press the {{{{User Tools}}}} key.

BBBB Press [Next].

CCCC Select [7 Set O/L Paramet's] using the {{{{~~~~}}}}, {{{{}}}}}}}}, {{{{||||}}}} or {{{{{{{{}}}} keys.

DDDD Press [OK].
The Online Parameter Settings item appears.

EEEE Select the item you want to change, and then press [OK].

FFFF Make any settings you require, and then press [OK].

Note
❒ To change the value entered, press the {{{{Clear/Stop}}}} key before pressing the

[OK] key. Then enter the new value.
❒ Press [Cancel] to return to the previous menu without changing any data.

GGGG Press the {{{{User Tools}}}} key to return to the standby display.

Note
❒ The settings are not canceled even if the main switch is turned off or the

{{{{Clear Modes/Energy Saver}}}} key is pressed.
❒ You can also return to the standby display by pressing the [Cancel] key.
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Type B

AAAA Press the {{{{User Tools}}}} key.

BBBB Select [6 Online Paramet's] using the {{{{~~~~}}}} or {{{{}}}}}}}} keys.

CCCC Press the {{{{OK}}}} key.

The Online Parameter Settings item appears.

DDDD Select the item you want to change, and then press the {{{{OK}}}} key.

EEEE Make any settings you require, and then press the {{{{OK}}}}.

Note
❒ To change the value entered, press the {{{{Clear/Stop}}}} key before pressing the

{{{{OK}}}} key. Then enter the new value.
❒ Press the {{{{Cancel}}}} key to return to the previous menu without changing

any data.

FFFF Press the {{{{User Tools}}}} key to return to the standby display.

Note
❒ The settings are not canceled even if the main switch is turned off or the

{{{{Clear Modes/Energy Saver}}}} key is pressed.
❒ You can also return to the standby display by pressing the {{{{Cancel}}}} key.
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Online Parameter Settings 

No. Mode Description

1 Set aut-O/L def. Sets Auto On Line to “ON” or “OFF” when the power has been 
turned on, or when the mode has been cleared.

Note
❒ Default: ON

2 Print Size def. Sets the print size selected when the power has been turned on or 
when the mode has been cleared.

Note
❒ Default: Auto

3 List/Test Print Prints the current set content of this machine.

Note
❒ Default: System Print

5 IP Address Sets the IP Address.

Note
❒ Default: 011.022.033.044

Reference
See Printer Reference 1 for information about the IP Address 
setting.

6 Ethernet Speed Sets the Ethernet communication speed.

Note
❒ Default: Auto

7 Network Sets the Network boot.

Note
❒ Default: None

Reference
See Printer Reference 1 for information about the Network boot 
setting.

8 I/O Timeout Sets the time to enable the interface after data stops being re-
ceived. When the time set here is exceeded, it will be possible to 
receive data from the other interface.

Important
❒ If the set time is too short, a time out might occur while one 

data is being received. As a result, data from another interface 
might cut in and be printed, or the emulation retrieval from 
half of the data may be activated, and be replaced with a dif-
ferent emulation.

Note
❒ Default: 30 sec.
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9 I/O Buffer Sets the capacity of the reception buffer.

Note
❒ Default: 512KB

10 Menu Reset You can reset the factory settings. However, the “IP Address”, 
“Network”, and the “Ethernet Speed” settings do not change.

No. Mode Description
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Machine Condition

We recommend that you print the system configuration list and check the cur-
rent system settings before changing them.

Printing the System Configuration List

Type A

AAAA Press the {{{{User Tools}}}} key.

The User Tools screen is displayed.

BBBB Press [Next].

CCCC Select [7 Set O/L Paramet's] using the {{{{~~~~}}}}, {{{{}}}}}}}}, {{{{||||}}}} or {{{{{{{{}}}} keys.

DDDD Press [OK].

The online print settings screen appears.

EEEE Select [3 List/Test Print] using the scroll key.

FFFF Press [OK].
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GGGG Make sure that [1 System Print] is selected and press [OK].

“Press the [Start] key to begin making the master.” appears.

HHHH Press the {{{{Start}}}} key.

The system configuration list is printed.

Type B

AAAA Press the {{{{User Tools}}}} key.

BBBB Select [6 Online Paramet's] using the {{{{~~~~}}}} or {{{{}}}}}}}} keys.

CCCC Press the {{{{OK}}}} key.

DDDD Select [3 List/Test Print].

EEEE Press the {{{{OK}}}} key.

FFFF Make sure [1 System Print] is selected, and then press the {{{{OK}}}}.

“Press [Make Master] to begin making the master.” appears.
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GGGG Press the {{{{Make Master}}}} key.

The system configuration list is printed.



6. Appendix
Specifications

This section contains the electrical and hardware specifications for the machine
including information about the options.

*1 To use NetBEUI, use the SmartDeviceMonitor for Client port.

Component Specification 

Resolution 400 dpi, 600 dpi

Parallel Interface Standard 36-pin printer cable and a parallel port on the host com-
puter.

IEEE1284

Note
❒ Do not use a parallel cable that is longer than 3 meters (10 feet).

LAN interface 100BASE-TX, 10BASE-T

Printer Language Raster Printer Language

Frame type EthernetII, IEEE802.2, IEEE802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 4.2, 5, 5.1 IntranetWare

• NetBEUI *1 

Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows XP
Windows NT 4.0

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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A

Advanced dialog box
Windows 2000,   10
Windows XP,   10

Advanced tab
Windows NT 4.0,   20

Appendix,   47

D

Device Settings tab
Windows 2000,   9
Windows NT 4.0,   19
Windows XP,   9

Display panel, Messages,   33

E

Error,   33
Ethernet Speed,   39, 42

F

Form To Tray Assignment
Windows 2000,   9
Windows NT 4.0,   19
Windows XP,   9

G

Graphics tab
Windows 95/98/Me,   3

I

I/O Buffer,   39, 43
I/O Timeout,   39, 42
IP Address,   39, 42

L

Layout tab
Windows 2000,   9
Windows XP,   9

List/Test Print,   39, 42

M

Menu Reset,   39, 43
Messages,   33

N

Network,   39, 42

O

Online Parameter Settings,   39, 42

P

Page Setup tab
Windows NT 4.0,   20

Paper/Quality tab
Windows 2000,   10
Windows XP,   10

Paper tab
Windows 95/98/Me,   2

Printer Properties Settings
Windows 2000,   9
Windows 95/98/Me,   2
Windows NT 4.0,   19
Windows XP,   9

Printing on custom sized paper
Windows 2000,   12
Windows 95/98/Me,   4
Windows NT 4.0,   22
Windows XP,   12

Printing on paper with a nondetectable size
Windows 2000,   14
Windows 95/98/Me,   5
Windows NT 4.0,   23
Windows XP,   14

Printing onto envelopes
Windows 2000,   16
Windows XP,   16

Printing the System Configuration List,   44
Print Size def.,   39, 42

R

Raster Printer Language
Windows 2000, uninstalling,   31
Windows 95/98/Me, uninstalling,   31
Windows NT 4.0, uninstalling,   32
Windows XP, uninstalling,   31

Resolution,   3

S

Set aut-O/L def.,   39, 42



T

Troubleshooting,   33

V

Various Types of Printing
Windows 2000,   12
Windows 95/98/Me,   4
Windows NT 4.0,   22
Windows XP,   12

W

Windows 2000
printer properties,   9
Raster Printer Language, uninstalling,   31

Windows 95/98/Me
printer properties,   2
Raster Printer Language, uninstalling,   31

Windows NT 4.0
printer properties,   19
Raster Printer Language, uninstalling,   32

Windows XP
printer properties,   9
Raster Printer Language, uninstalling,   31
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